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Goals 
 

In this lesson, you will learn:  

• how vector and raster data are structured  
• how to choose the appropriate data structure  
• how grid themes use cells to store geographic information  
• how to use the sample CellTool extension to examine cells in a grid theme  

TOPIC1: Vector or raster? 
 

Vector themes are similar to raster themes because they both represent a layer, or set of 
geographic features. While vector and grid themes may represent the same geographic features 
and look similar (depending upon cell size and resolution), the storage structure, usefulness, and 
analysis of each is very different. 



 
You can represent geographic features in either 
vector or raster format. 

There are several issues to consider when deciding which format is most appropriate; these 
include the kind of geographic features or phenomena being represented and the type of 
modeling you want to do.  

Use the raster or grid theme format when you want to work with multiple data types (points, 
polygons, lines, or surfaces) in the same environment; when you want to model attributes of 
locations on the Earth's surface; or when you need to work with continuous surfaces and discrete 
data.  

Use the vector or feature theme format when precise measurements are needed; for instance 
with pipe, cable, or legal boundary locations. Feature themes can represent geographic features 
with great precision 

Concept 
 
Choosing a data structure 
 

This concept presents a comparison of the raster and vector data models. The objective is to 
review the characteristics of each and compare their relative strengths and weaknesses. 
Although it is difficult to specify exact rules to which the raster and vector data structures adhere, 
below are some useful generalizations that apply. Depending on the type of analysis you're 
performing, you may use vector data or raster data or both.  

• The primary focus of the vector data model is the geographic feature; the primary focus 
of the raster data model is location.  

• The vector model is more suited to the question, "What do I know about this geographic 
feature?" The raster model answers the question, "What geographic phenomenon occurs 
at this location?"  

• The vector model uses x,y coordinates to represent geographic features; the raster 
model stores rows and columns of cell values.  

• The vector model defines boundaries. There are no boundaries defined in the raster 
model.  

• The vector model represents locations as x,y coordinates in a Cartesian coordinate 
system. The raster model represents location as cells, also in a Cartesian coordinate 
system.  

• The vector model represents feature shape accurately; the raster model represents 
rectangular areas and thus is more generalized and less accurate.  



• The vector model represents features with well-defined boundaries; the raster model 
represents a more generalized view. The raster model can also represent gradual 
transition between features and surfaces, such as soil classification and elevation.  

• The vector model is used for high-quality cartography and for applications in which 
accuracy and precision are important, such as for cadastral applications. The raster 
model is useful for image/picture storage and is well suited to many spatial modeling 
operations, such as optimum corridor route selection, surface storm runoff modeling, and 
forest fire modeling.  

• The overlay operation examines two datasets to determine what geographic features 
exist at the same location. Overlaying vector feature themes is a complex operation, 
while the nature of the raster data model allows simple and fast overlays. 

 

 
Overlaying polygon vector themes can be computationally complex. By contrast, 
an overlay can be a simple operation when you're working with grid data 
because cells from the grid layers stack directly on top of each other. 

 
TOPIC 2: Cell basics 
 

In this topic, you will learn about cells, the basic spatial unit for a grid theme.  

The grid theme's cell-based structure divides the world into individual locations that are uniquely 
described. This structure allows the modeling of locational problems. These include problems 
where a geographic features's surroundings and location are as important (or more important) as 
the feature makeup. 



 
This diagram is a generic representation of a grid. 
The cell is the basic spatial unit used in ArcView 
Spatial Analyst. The whole extent of the data is 
covered by an interlocking matrix of square, 
identically-sized cells. 

 
Concept 
 
What is a cell? 
 

As you've learned, the cell is the basic spatial unit for a grid theme. Cells are squares (they have 
equal height and width). You can define cells to be any size, but they should be small enough to 
define the most detailed geographic feature to be analyzed. For example, if you were trying to 
identify locations for a mini-mart, it would be more appropriate to use a 20-meter cell size than a 
1-kilometer cell size.  

Cell locations are referenced by their row and column position (e.g., the red-shaded cell below is 
at row 2 and column 3). Every cell can be uniquely identified by its row and column position. 

 
The top left cell in a grid is at the 0,0 position. 



The rows and columns are numbered from the top left corner of the grid theme. The index 
numbers start with zero. The cell in the top left corner is numbered 0,0. The 0,0 cell is the row 
and column index position origin of the grid.  

In a grid theme, the number of rows and columns does not have to be the same. For example, 
your grid theme may have 2000 rows and 1857 columns 

Concept 
 
Cell values 
 

Cells are assigned an integer, floating point, or No Data value.  

Integer values often use a code that identifies a cell with its category. In the example below, 1 is 
the code for the Forest category and 2 is the code for the Water category. Grid themes with 
integer values have a theme table--called a value attribute table (VAT)--that stores the codes and 
categories. Grid theme tables will be discussed in more detail in Lesson 2.  

In a floating point grid, each cell location stores a value that represents a measure of a 
geographic phenomena. A floating point grid represents one phenomenon (feature or attribute) 
like elevation, rainfall, noise level, or slope.  

Each cell stores a value representing a reading or measure for the phenomena at its location. In 
the example, cell 0,0 stores a value of 1.112. That cell represents a value of 1.112 inches of rain. 
Its neighboring cell (0,1) stores a value of 3.822 inches of rain. Potentially, each cell in the grid 
theme can have a different value. 

 
Representations of integer and floating point grids. 
Integer grids store categorical data like land use. 
Floating point grids store continuous data like 
precipitation. 

Floating point grids have no theme table. It is possible, however, to convert a floating point grid 
into an integer grid.  

No Data is a non-numeric value assigned to cells when insufficient information is available about 
the location. For example, the rainfall monitoring stations may not have reported or recorded any 
rainfall amounts. During calculation operations and analysis functions, cells with a No Data value 
are treated differently than cells with a value. You can exclude cells with the No Data value during 
statistical analysis.  



The Avenue requests Float and Int convert a grid theme to floating point and integer values, 
respectively. The Float request converts each cell into a floating point value. The Int request 
converts each cell to an integer value by truncating at the decimal point. You can issue these 
requests inside the Map Calculator. You'll learn more about requests in Module 3, Using Map 
Algebra in ArcView Spatial Analyst. 

Concept 
 
Identifying cells 
 

The Identify tool displays information for a selected cell in the active grid. The x,y coordinates of 
the cell center and cell's value are reported. If you are identifying cells in an integer grid, all the 
attribute values from the VAT are reported, including any values from joined tables.  

When you use the Identify tool on a feature theme, the point, line, or polygon feature flashes. 
When you use the Identify tool on a grid theme, however, cells do not flash and no mark is left to 
signify the identified cell. 

 
You can use the Identify tool to display cell values 
and other attributes. 

Concept 
 
The CellTool sample extension 
 

The CellTool sample extension is a sample extension developed by the ESRI Training 
Department. The CellTool extension is composed of four tools to help you examine individual 
cells and their values. Normal interaction with a grid theme usually does not occur at the cell 
level. During error-checking or detailed analysis, however, these tools may prove useful.  

You load this extension just like you would load any other extension. The extension file, 
Celltool.avx, is included as a sample extension with ArcView Spatial Analyst and can be found in 
the esri\av_gis30\arcview\samples\ext folder. When the new tools appear, you need to zoom in to 
the desired area. It is important to zoom in to a small area of the grid theme; if you don't, the 
resulting graphics will not be legible.  

The four tools included with the CellTool extension are: RowAndColumn, CellValue, CellDraw, 
and CellArrow.  

• The RowAndColumn tool displays the cell row and column numbers in the status bar. 



 
The RowAndColumn tool of the 
CellTool extension displays cell row 
and column numbers in the left part 
of the status bar. 

• The CellValue tool displays the selected cell's value. Click anywhere inside the cell and 
the value will display at the center of the cell. 

 
The CellValue tool displays a cell's 
value in its center when you click on 
the desired cell. 

• The CellDraw tool draws the selected cell and the surrounding eight cells. Click anywhere 
inside the cell and the nine cell boundaries will be drawn. 

 
The CellDraw tool draws the selected 
cell and the surrounding eight cells. 



• The CellArrow tool is useful when you're working with aspect (hill direction) or watershed 
surfaces (water flow direction). Click anywhere inside a cell and an arrow draws pointing 
downhill or in the flow direction. The direction of the arrow is determined by the cell's 
value (0 to 360). 

 

 
The CellArrow (Direction) tool draws 
arrows indicating the direction downhill 
or the flow direction. 

Note: The CellTool sample extension is for sample and demonstration purposes only. It is not an 
ESRI-supported extension 
 
Exercise 
 
Use Identify and CellTool to examine grid cells 
 
In this exercise, you'll examine a grid theme at the 
more detailed cell level using the Identify tool and a 
sample extension of cell examination tools. 

  

  
 
If you have not downloaded the exercise 
data for this module, you should 
download the data now. 

     
 

Step 1  
 
Start ArcView 

  

Start ArcView and load the Spatial Analyst extension.  

Note: If you're running ArcView GIS 3.1, you see a Welcome to ArcView GIS dialog. 
Click Cancel to close this dialog. 

If ArcView is already running, close any open projects. 

  

 
Step 2  

 
Open the project  

  
From the File menu, choose Open Project. Navigate to the gridsa\lesson1 folder and 
open the project l1_ex01.apr.   



Note: If you are running ArcView GIS 3.1, you see an Update l1_ex01.apr message 
box. Click No to dismiss this box. 

When the project opens, you see a Landuse view containing a Landuse theme. 

 
 

Step 3  
 
Examine cell values with the Identify tool  

  

With the Landuse grid theme active, click the Identify tool and then click on 
various cells in the Landuse grid theme. 

Click on some Agricultural and Vacant cells.  

Identify displays the Value, Count, and Landuse_type2 field values for a chosen cell. 
The cell does not highlight and there is no indication of which cell you selected. The 
Landuse view is displayed at a small scale (about 1:78,000), so it is difficult to see the 
individual cells.  

Next, you will see how Identify tool can be more useful. 

Close the Identify Results window. Close the Landuse view. 

 

  

 
Step 4  

 
Open the Zoomed Landuse view  

  

Open the Zoomed Landuse view.  

This view is zoomed to a large scale (about 1:2800). At this scale, the individual cells 
representing the land use features become visible. Notice the nine cells in the upper-
left with their cell outlines drawn. 

 

  

 
Step 5  

 
Examine cell values with the Identify tool  

  

With the Landuse grid theme active, use the Identify tool to select a few cells in 
the Landuse grid theme. 

At this detailed level of display, it would be useful to actually draw the cell boundaries 
or display the cell value at the center of each cell. For this purpose, a sample 
extension called CellTool will be used. 

  

 
Step 6  

 
Examine the CellTool extension  

  
The CellTool extension has already been loaded into this project. Notice the four extra 
tools on the toolbar. 

 
  

 
Step 7  

 
Use the CellDraw tool  

  
First, you will try out the CellDraw tool. When you click a cell with this tool, its 
boundary (outline square) draws and the boundaries of the eight surrounding 
(contiguous) cells draw. When you first click any of these tools, you are questioned 

  



about saving the graphics.  

If you choose Yes, any graphics are drawn and saved in the view. If you choose No, 
the graphics are drawn but they are not saved. If you zoom in or out, the graphics will 
disappear. You can redraw the graphics at any time, however.  

In the Zoomed Landuse view, click the CellDraw tool and click Yes when 
prompted to save the graphics. 

Now use the CellDraw tool to select a cell anywhere on the Zoomed Landuse grid.  

Notice that the cell boundary (outline) draws for that cell and its eight surrounding 
(contiguous) cells. 

Try this tool a few more times by clicking on other cells. Don't worry if you make a 
mistake. Those cell boundaries are simple graphics (rectangles). You can select them 
and delete them using Select All Graphics and Delete Graphics from the Edit menu. 

 
 

Step 8  
 
Use the RowAndColumn tool   

  

Next, you will try out the RowAndColumn tool. When you use this tool to select a cell, 
the cell's row, column, and value are displayed as messages in the status bar. The 
cell you select also appears highlighted. 

Use the RowAndColumn tool to select the cell at the upper left corner of the grid. 
Look at the status bar for that cell's row and column.  

The cell at the upper left corner of any grid is the origin cell and is therefore row 0, 
column 0.  

Select a few more cells that have different values. Also try clicking on a No Data cell 
or a cell outside the grid boundary. 

  

 
Step 9  

 
Use the CellValue tool  

  

Next, you will use the CellValue tool, which displays the value inside the selected cell. 
Graphic text draws in the view's display area if you answer Yes when prompted to 
save the graphics.  

Use the CellValue tool to display the values of some of the cells that you 
previously selected with the CellDraw tool. 

 

  

 
Step 10  

 
Use the CellArrow tool  

  

Finally, you will open a different view and use the CellArrow tool. 

Close the Zoomed Landuse view. Open the Redlands Hills view.   



The Redlands Hills view contains an elevation and an aspect theme.  

Use the Zoom In tool and zoom in on the upper-right portion of the Elevation 
theme until the scale is at about 1:14000.  

With the Elevation theme active, use the CellDraw tool to display some cell 
boundaries.  

Use the CellValue tool to display elevation values for these cells.  

Zoom in further if you cannot see the cells or their values. From the Edit menu, 
choose Select All Graphics, then Delete Graphics. 

Turn off the Elevation theme. Turn on the Aspect theme and make it active. 

Aspect is the orientation of a hillside (e.g., angled toward the north, south, east, or 
west). Distinct colors are used to represent different aspects. For example, the blue 
shades indicate the slope is facing south, southwest, or west.  

Use the CellDraw tool to draw nine cells anywhere on the view. Then use the 

CellArrow tool to display the direction arrows for those nine cells.  

The arrows point downhill. If you poured water on that hillside, the water would flow in 
the same direction as the arrows.  

Use the CellValue tool to select those same nine cells. You may have to zoom to read 
the values.  

The numbers reported will be from 0 to 360.  

Aspect (the direction of the slope) will be fully discussed in Module 5, Introduction to 
Surface Analysis with ArcView Spatial Analyst. 
 

Step 11  
 
Close the project  

  

Close the project without saving any changes. 

If you want to use the cell tools in another project, the celltool.avx extension file is 
included as a sample extension with ArcView Spatial Analyst. Load and use it as you 
would any other sample extension. 

You have completed this exercise 

 

Summary 
 

In this lesson, you learned the basic differences between vector and raster data structures. 
Vector themes store points, lines, and polygons with x,y coordinates, while raster themes store 
points, lines, and polygons as a matrix of cells. Vector and raster data structures can both 
represent the same geographic features, but each has its own strengths and weaknesses.  



The vector data structure represents features very accurately. The shapes, sizes, and attributes 
associated with objects are best handled in a vector environment. The raster structure is best for 
locational analyses, modeling the attributes of locations on the Earth's surface, and working with 
multiple data types in the same environment. 

The cell is the basic spatial unit for a grid theme. Cells can be any size, are square, are organized 
into rows and columns. Cells store either integer or floating point values that represent 
geographic features. Only integer grids have a VAT. 

The Identify tool can be used to see cell values and any other attributes. The CellTool sample 
extension allows you to examine individual cells in detail 

This is the Understanding the ArcView Spatial Analyst Grid Model - Lesson 1 Self test. 
 Please watch your time—you have 2 hours to complete this test.  

Use the knowledge you have gained in Understanding the ArcView Spatial Analyst Grid Model to 
answer the following questions. You will need to correctly answer 7 of the following questions to 
pass.  

Netscape Users: Do not resize this browser window. This can cause the page to reload 
and generate new questions.  

GOOD LUCK!  

 
1.  There are no boundaries defined in the raster data model. 

True 

False 

2.  It's best to use the raster data model when precise measurements are needed. 

True 

False 

3.  Cell locations are referenced by their row and column position. 

True 

False 

4.  The Identify tool will display attribute values from the VAT of a floating point grid. 

True 

False 

5.  Cells may be assigned either an integer, floating point, no data, or character value. 

True 

False 



6.  You can convert a floating-point grid to an integer grid. 

True 

False 

7.  The row and column index position origin (0,0) of a grid is at the grid's lower left. 

True 

False 

8.  The number of rows in a grid theme must match the number of columns. 

True 

False 

9.  Which of the following is found within the CellTool sample extension? 

ColumnReverse tool 

CellArrow tool 

CellColor tool 

Identify tool 

10.  Which of the following is true about the vector data model? 

It represents feature shapes accurately 

It defines boundaries 

Overlaying vectors is complex 

All of the above 
 

 

Calculate My Grade
 

 


